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1 Introduction 
 

 

Welcome to use the Genorama® Genotyping SoftwareTM 

4.5, a microarray image analysis software specifically 

designed for genotyping by Arrayed Primer Extension 

(APEX). This is a high-throughput genotyping method 

combining both high information content of 

oligonucleotide microarray and reliability of a genotyping 

method, based on single base primer extension. Our 

software is compatible with microarray images from 

primer extension assays combined with single, dual or 

four-colour detection.  

 

The analysis using images from an APEX assay is 

performed as follows: four image files with signals from 

different dye terminators are opened. A grid is set up 

over the microarray**.  The signals on the images are 

identified and quantified. The signal intensities on the 

same location (spot) are compared between different 

images and the base calls are made.  

 

Genorama® Genotyping SoftwareTM 4.5 contains two 

main utilities: BaseCallerTM for analysis of one sample at 

a time and PicDBTM for simultaneous analysis of multiple 

images by the same address. 

 

* For more information on APEX method, please visit our 
homepage at http://www.genorama.com/ 
** Whenever multiple grids are located on the same 
image, they must be set up and analyzed separately 
 

References: 

 

Kurg A, et al.. Arrayed Primer Extension: Solid phase 
four-color DNA resequencing and mutation detection 
technology. Genetic Testing 2000; 4(1):1-7 
 
Tõnisson N, et al. Evaluating the arrayed primer 
extension resequencing assay of TP53 tumor suppressor 
gene. Proc Natl Acad Sci USA 2002; 99(8):5503-8 
 

 

 

BaseCallerTM PicDBTM Genorama® ConverterTM 

 

Main program for analysis by single 

sample and to save image to database 

for analysis by PicDBTM. 

 

Main program by parallel analysis of 

multiple samples. 

 

Converts tab delimited txt tables and 

20-space blocks into Genorama 

reference tables (array positions with 

expected basecalls). 

 

 

 

 

 

 
 

 

 

1.1 About This Manual 
 

 

The Genorama® Genotyping SoftwareTM 4.5 User Guide 

provides detailed information about the tools and 

commands available. This manual is designed to be used 

as a reference tool in your everyday work with the 

Genorama® Genotyping SoftwareTM 4.5. 

 

This manual assumes you have a working knowledge of 

your operating system and its conventions, including 

how to use a mouse and standard menus and 

commands, and how to open, save, and close files. For 

help with any of those techniques, please see your 

Microsoft Windows documentation. 

 

The manual is in PDF format. You can display the 

manual on your computer screen and print it out, if 

required. To access the manual you need to install the 

Adobe
®

 Acrobat
®

 Reader
TM

 (http://www.acrobat.com/). 

 

 

 

 

BaseCaller Genorama  

Converter 
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1.2 System Requirements 
 

 

To use the Genorama® Genotyping SoftwareTM 4.5 you 

need the following hardware and software: 

 

• An Intel
®

 Pentium
® – class or faster processor 

(Pentium IV with 1GHz CPU or better 

recommended) 

• Microsoft Windows XP or later only. 

• At least 128 megabytes (MB) of random-access 

memory (RAM) (512 MB recommended). 

• A video card displaying minimum of 1024 x 768 

pixels of desktop area. 

 

Genorama® Genotyping SoftwareTM 4.5 performance 

improves with faster versions of PC, more RAM, fast and 

large hard disk drives. 

 

 
 

 

1.3  New in This Version 
 

The new features in Genorama® Genotyping SoftwareTM 4.5 are: 

 

Genorama® BaseCallerTM 4.5 module 

 

- New automatic grid placement module for image 

segmentation. After four clicks in the grid corner marks 

the software automatically locates signals and places 

grids on the four images. 

 

- Genorama results window includes also PicDB section 

 

- The field of notes and reference has unlimited 

characters space. 

 

PicDBTM 4.5 module 

  

- 2D clustering for automated genotyping is fully 

functional and linked with basecalls 

 

- Both programs contain bug fixes for the older versions. 

 

- The field of notes and reference has unlimited 

characters space. 

 

 

Note: Microsoft Windows  XP is the recommended OS 
with Genorama® Genotyping SoftwareTM 4.5 

  

 

 

 

1.4 For Additional Information 
 

 

Additional information about the software can be found in the following: 

 

1. Web Site – http://www.genorama.com/ 

2. Sales Support by e-mail  - info@genorama.com 

3. Technical Support by e-mail - techsupport@genorama.com 
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1.5 Image Analysis Process 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 BaseCallerTM 

 PicDBTM 

 Genorama® ConverterTM 

 

 

 

Figure 1. Image Analysis Process 

 

Open Image 

Analyze by single 
samples Analyse by SNP-s or 

mutations 

Save results 

Define Grid Properties 

Adjust Brightness 
(optional) 

Grid Set-up 

Scan Images Save to Image database 

Open Results 

Load Reference and 

Notes file 

Open PicDBTM database and 
scan images 

Load Reference file and 
Notes file 

Define oligo position on 

grid in MS Excel 
(optional) 

Convert the table to txt – 
format (optional) 

Reference file 

Save results 

Convert the txt – file to 
grf format (optional) 
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BUTTONS 
 

Open Images 

 

A image  
 

C image 
 

G image 
 

T image 

 

Grid Setup 

 

 

Scanning 

 

Results 

 

 

Move Image 

 

 

Options panel 

 

 

Loupe 

 

Zoom In 

 
 

Zoom Out 

 
Brightness 

 
Panorama 

2 BaseCallerTM 
 

2.1 Main Window 
 

 

 

 

 

 

 
Figure 2. Genorama® BaseCallerTM Main Window 

 

Menu Bar 

Toolbar 
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2.2 Working with Images 
 

 

BaseCallerTM works with images saved in TIFF file format 

(Tagged-Image File Format). 12 or 16 bit digital APEX 

microarray images can be acquired with Genorama® 

QuattroImager or with other microarray imaging 

systems. 

 

 

  

2.2.1 Opening Images 
 

 Choose Open image files from File menu or click 

on the Open button on the toolbar. After adjusting Grid 

properties (See also section 2.2.1) the Open image files 

dialog box (See Figure 3.) appears.  

 

BaseCallerTM lets you open up to four image files. To 

select and change image files click the Browse button. 

 

Note: If you select a file with A, C, G or T in the end of 
the file name (e.g heart,056A.tif), BaseCallerTM 
automatically searches for and selects the other three 
images. 
 

 

 
 

Figure 3. Open image files dialog box  

 

With the Open command you can also adjust image 

brightness, rotate images and select image palette. 

Default settings are memorized from the last images 

opened. 
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II 

 

 

 

 

 

I 

2.2.2 Adjusting Image Brightness  
 

           
 

 
 

I  Rainbow  III Green to Red 

II Plasma  IV Grayscale 

  
Figure 4. Different colour palettes 

Using the Brightness command is the simplest way to 

adjust appearance of your image. You can change 

images’ brightness and select palette.  

 

 Choose the Brightness command or click the 

Brightness icon on the toolbar. 

 

Note: None of the changes have a permanent effect on 
your image files.  
 

To adjust images’ brightness do one of the  

following: 

• Drag the sliders to adjust the brightness. 

• Click the Auto button to set the overall 

brightness of images to the optimal level. 

 

To rotate images do the following: 

• Select 90 degrees and CW to rotate clockwise 

by a quarter-turn. 

• Select 90 degrees and CCW to rotate counter-

clockwise by a quarter-turn. 

• Select 180 to rotate by a half-turn. 

 

To select image palette do the following: 

• Click the Grayscale, Plasma, Rainbow or 

Green to Red radio button to select image 

palette. Different image palettes (See Figure 

4.) are for better visual identification and do 

not affect the results. 

 

2.2.3 Magnifying and Reducing The View 
 

 

You can magnify or reduce your view using various 

methods.  To zoom in do one of the following: 

• Click the Zoom in button on the toolbar. 

• Select exact percentage from the Zoom menu. 

 To zoom out do one of the following: 

• Click the Zoom out button on the toolbar. 

• Select exact percentage from the Zoom menu. 

 

2.2.4 Using The Loupe Tool 
 

The loupe tool lets you see the parts of the image in 

detailed view without magnifying the whole image. 

 

 To use the Loupe tool do the following: 

• Choose Loupe from Tools menu or click the 

Loupe icon on the toolbar. The loupe window 

(See Figure 5.) appears. 

• Move mouse around the image to see the 

detailed view inside the loupe window 

 

 

 

Figure 5. Loupe window 
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2.2.5 Using The Panorama Tool 
 

The panorama tool shows your location on image and lets 

you move fast from one location to another 

 

 To Use the Panorama tool do the following 

• Choose Panorama from Tools menu or click the 

Panorama icon on the toolbar. The panorama 

window  (See Figure 6.) shows your exact location 

on image 

• To move from one location to another click on the 

exact location on image. 

 

 

 

 
 

Figure 6. Panorama window 
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A 

 
 

Figure 7A. Grid properties window 

 

B 

 
 

Figure 7B. Grid setup window 

 

2.3 Setting Up Grids 
 

2.3.1 Setting Grid Properties 
 

In BaseCallerTM you set grid dimensions and grid cell recurrence immediately 

after the images are opened (See Figure 7A). Grid dimensions give the number 

of columns and rows of the grid. Grid Cell recurrence sets the number of 

identical neighbouring spots for the same oligonucleotide in the array. Technical 

block size sets the number of spots on array printed with a single pin. This 

allows correcting minor array deformations due to differences between the pins 

used for microarray printing. 

 

Grid dimensions must fit the pattern of spots on the image.  

To set up grid properties do one of the following: 

Adjust the Grid size, Grid Cell recurrence and  

Technical block values to fit your image, click OK and proceed with grid setup 

(See also section 2.3.2). 

 

To change grid properties do the following: 

• Choose Grid properties from Tools menu. The Grid properties dialog 

box appears.  

• Adjust the Grid size, Grid Cell recurrence and Technical block values 

to fit your image and click OK. 

 

 

2.3.2 Setting Up Grids Automatically 
 

To analyze the images a grid must be set up over the array area. The Grid tool 

lets you to segmentate the signals from regular array. 

 

 Choose Grid setup from Tools menu or click the Grid setup icon on the 

toolbar. Grid setup window appears (See Figure 7.). 

 

Grid dimensions must fit the pattern of spots on the image. If you have set 

incorrect grid dimensions during the load time you have to correct them before 

setting up grids. 

 

 

Click the Automatic grid setup button in the grid setup window. Select all four 

corners of the array. BaseCallerTM automatically checks the presence of signals 

on the selected positions and automatically places grid over the image. 

 

After selecting four corners on array the program prompts you to confirm the 

technical block size. Select Automatic setup if you don’t know the technical 

block size values. The program will automatically select values to compensate 

the array irregularities. Select Manual setup if you wish to set up the grids 

manually. 

 

Note: Use the arrow buttons to scroll the view if necessary. 
 

 

2.3.3 Setting Up Grids from last session 
 

Grids from last session uses the grid size and location parameters from the last 

time the image was analyzed. 

 

Click the Grids from last session button in the setup window. Grid appears on 

the image. Check grid size and location in each channel. Click the Next image 

button after each completed image. 

 

Note: It is very important to set up grids correctly. Incorrect grid set-up affect 
signal quantification and can produce incorrect results.

 

 



 Genorama® Genotyping Software TM 4.5 

 
 

  

 

13 

 

 

 

2.3.4 Adjusting Grid Size and Location 
 

BaseCallerTM lets you to adjust grid size and location using several tools. Use them if signals are not located in the centre 

of the grid cells. 

 

Arrow buttons Use the arrow buttons to adjust the grid location.  

If the Image radio button is selected, you can scroll the view using the same arrow buttons. 

 

Zoom buttons Use the zoom buttons to magnify or reduce the view. 

Rotate buttons Use the Rotate CW button to rotate grid clockwise. 

 

Use the Rotate CCW button to rotate grid anticlockwise. 

 

Squeeze/Widen buttons Use the Squeeze button to reduce grid size. 

Use the Widen button to increase grid size. 

 

Step value indicates the distance of grid movement in pixels each time an arrow button is clicked. 

 

 

2.3.5 Setting Sub-Grids Manually 
 

 

The sub-grid tool lets you manually divide the grid into sections. 

Use this tool to adjust each section separately, if your images have 

irregular spotting pattern, which is not corrected, by automatic grid 

placement. 

 

To set up sub-grids do the following: 

 

• Click the Sub-grid menu from the Grid setup window. The 

Sub-grid selection window appears (See Figure 8.).  

• If you want to set up or change sub-grids, click the Divide 

button. 

 

 

Vertical/Horizontal lines - Select Vertical radio button to draw 

vertical lines or Horizontal radio button to draw horizontal lines. 

 

Up/down Left/Right buttons - Use those buttons to move line 

up/down or left/right by one step. 

 

Cancel button - Click the Cancel button to discard your changes. 

 

Reset button - Click the Reset button to remove all sub-grids. 

 

OK button - Click the OK button to confirm your selection. To 

specify a part of grid to be adjusted, click on screen and the 

selected area become highlighted. 

 

When you exit the part selection window the selected part remains 

highlighted in the main grid setup window. Now grid adjustments 

will be applied to the highlighted part of the grid. 

 

To select a subgrid on the BaseCallerTM main window: 

• Click Select sub-grid on Grid setup window (see Figure 

7B). The Grid setup window will be temporarily closed. 

• Click on the subgrid to be selected on BaseCallerTM main 

window. 

 

 
 

 

Figure 8. Sub-grid selection window 
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2.4 Creating and Opening Image Database 

 
 

Image database is useful for retaining and comparing 

images, especially for single nucleotide polymorphism 

genotyping. Image database lets you open one position 

from each image and compare them across the database 

using Genorama® Genotyping SoftwareTM 4.2.9 PicDBTM 

program (See also section 3.1). 

 

To create a new image database do the following: 

• Click the Save to PicDBTM menu. 

• Change image database folder, if necessary. 

• Type the sample name in the textbox and  

• Click OK. 

 

To save images to the database do the following: 

• Click the Save to PicDBTM menu. 

• Select your image database folder. 

• Type the sample name in the textbox and  

• Click OK. 

 

NOTE: A new image database name is composed from 
grid dimension values. For example if your grid has 20 
horizontal and 6 vertical cells the image database 
name is 20x6_1p.mdb. Additional databases- 
20x6_2p.mdb, 20x6_3p.mdb will be automatically 
created if a large number of images will be stored for 
the same grid size. 
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2.5 Scanning Images 
 

 

 First you must adjust image scanning and signal 

detection options. Choose Options from Tools Menu or  

 
click the Options button on the toolbar. The options 

window appears (See Figure 9.) 

 

 

 

2.5.1 Specifying Image Scanning Options 
 

 

Choose between 2 signal detection algorithms: 

• Cluster Analysis detects signal as the bright 

group of pixels (the only recommended option 

for 16 bit images) 

• Gaussian Approximation finds signals according 

to geometrical distribution of intense pixels. 

 

Valid diameter signals only - Use this option to 

eliminate small signals, probably artifacts. 

 

Geometry Control  - Use this option to eliminate 

signals that differ significantly from perfect circle, 

probably artifacts 

 

Local background subtraction - Use this option to 

subtract the value of the background around the spot 

from the integrated volume of pixel intensities used for 

calculation of the signal intensity value. 

 

Sensitivity - Use a sensitivity threshold to eliminate low 

intensity signals 

0% - only signals with high intensity are counted 

100% - all found signals are counted and quantified 

 

Floating cells - Use this option for better recognition of 

the signals, which are not in the middle of the cell but 

are located on the border of the grid cell. BaseCallerTM 

searches area around the cell and automatically aligns 

the area for quantification according to the signal 

location. The area for this search is defined by the 

extent of border %. 

0% - the actual cells within their visible border 

will be scanned. 

30% - the actual cell plus area around the cell, 

30% larger than the original cell, will be 

scanned. This improves signal recognition on 

arrays with moderately distorted columns and 

lines. 

 

Show Floating Cells - Use this option to visualize the 

actual scanning alignment of cells. 

 

Note: there are also options for blue cells, which are 
useful in results window (See also section 2.6) 
 

 

 

 

 

Figure 9. The Options window. 
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 When scanning options are specified, choose Scanning from Tools menu or click 

the Scanning button on the toolbar or click the Scan images button in the Grid setup 

window. The Image Scanning window (See Figure 10.) appears. 

 

2.5.2 Scanning Multiple Images 
 

Click the Scan all images button to scan all images with the same scanning and 

signal detecting options. 

 

Click the Scan current image to scan only one image at a time. This tool lets you 

specify different image scanning and signal detecting options for each image. 

 

 

2.5.3 Eliminating Quantification of Weak Signals  
 

When images are scanned and all signals are found, there may still be weak 

signals that may affect basecalls. Intensity threshold tool is used for eliminating 

these weak signals. 

 

Use Intensity threshold tool as follows: 

• Scan at least one image first.  

• Click Set. The Intensity threshold window (See Figure 11.) appears. 

• Choose a set of weak nonspecific signals by clicking on image to assign 

the threshold according to their maximum or mean intensity.  

• Select, which images from A, C, G and T will be affected by the threshold 

set and the signals scan images again. 

 

 

 
 

Figure 10. The Image Scanning 

window. 

 

 
 

 

 

 

Figure 11. The Intensity Threshold window. 

 

 

 

2.5.4 Visualising Signal Pixels 
 

To visualize signal pixels of and view various pixel 

statistics press Ctrl and click on the scanned signal.  

 

The signal- and background pixels with their parameters 

window (See Figure 12.) appears.  

 

 
 

Figure 12. The signal- and background pixels with their 

parameters window
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2.6 Sequence Analysis And Genotyping In Results Window 
 

 
To open the Results window choose the Results menu 

on menu bar or click the Results button on toolbar. The 

Results window (See Figure 13.) appears. 

The Results window gives you tools for performing 

APEX-based genotyping. BaseCallerTM supplies you with 

signal intensity values for each channel and preliminary 

basecalls in a 2D spreadsheet according to the intensity 

of each primer position in APEX microarray. You can add 

notes, view detailed signal and reference information for 

a particular base or view a base pair if oligonucleotides 

for both DNA strands were arrayed. (For more 

information about APEX-based genotyping please read: 

 “APEX – Arrayed Primer Extension”, 

http://www.genorama.com). 

 

 

 

 

 

 

Selected cell 

Base calls table 

The image 

fragment of 

selected cell in 

each channel 

Figure 13. The results window 

 

Same position of 

other samples 

within selected 
PicDB database 

Reference and 
Notes window 
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2.6.1 Identifying and Accepting Signal Values for Each Channel 
 

Click the A, C, G or T menu to view signal values for 

each channel. There is a separate table for each channel. 

 

The light blue cells show a possibility of an artifact: a 

signal has been identified, but it is not confirmed by a 

repeat of the same spot. This may happen if the same 

oligonucleotide is printed on the slide in duplicate (See 

also section 2.7.2). 

 

As a tracking feature, already inspected cells have a 

darker background. 

To identify and accept signal values do the  

following: 

• Click a cell to select it or press the space key 

on the keyboard to see the images 

corresponding to particular signal. 

• Verify signals visually (See  Figure 15.). 

• To select the next light blue cell press the Z 

key 

 

Genorama® BaseCallerTM and PicDBTM permit for 

filtering against known false-positive signals in 

microarray. 

 

To use the filter do as follows: 

• Open or create a new Notes file. Add excl N 

or exclude N to the end of the note for the 

particular microarray position. N is the image 

(A, G, C or T) where quantitation is not 

required. 

 

2.6.2 Genotyping Results in Base Calls Table 
 

 

Click the Base Calls menu of the results window (See 

Figure 13.) to view base calls table. Base calls table is 

the main tool for sequencing and genotyping results 

according to the Arrayed Primer Extension (APEX) 

microarray.  

 

Light blue cells in the table show that this position needs 

to be verified visually (See Figure 13.). 

 

Already inspected cells have a darker background. 

 

Exclamation mark (!) is used if the given base and the 

Genorama® reference file with expected base calls do 

not match (See section 2.6.5). 

To edit base calls table do the following: 

• Click a cell to select it or press the space key 

on the keyboard to see the images 

corresponding to particular base call. 

• Press the Enter key on the keyboard to correct 

values. 

 

To compare the results with other samples: 

• Click to the button Open PicDB  

• Select the position in base calls table  

• Click to the button Show. 

 

 

You can reset all the changes you have made in base 

calls table or you can load saved base calls table. 

 

 

 

2.6.3 Identifying Signals in Detailed View Window 
 

 

To identify Signals in Detailed View Window of 

selected cell: 

• Double-click on any of the four signal windows 

every pixel is one block and its height depends 

on signal intensity. 

 

In detailed view you can view image with different palette 

and brightness values. Different image palettes are for 

better visual identification and do not affect the results.  

 

The Zoom tool lets you view the signal from front and 

back view or adjust the scale for signal intensities.  

 

Use those tools to identify visually complex or faint 

signals. 

 

 

 

 
 

Figure 14. Detailed view of selected cell 
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   Average         

   Signal intensity 

   of the sample 

 

Figure 15. Part of results window.  

 

 

2.6.4 Using Notes 
 

 

Use Notes tool to store comments or performance of 

particular array cells such as possible unspecific signals. 

 

To edit notes table do one of the following: 

• Click the Notes menu to open notes table. 

• Click a cell to select it or press the space key 

on the keyboard. 

• Press the Enter key on the keyboard to enter 

new value. 

• Click the Notes window on the lower left 

corner of the Results window and enter new 

value. 

 

 

 

To undo changes in notes table do one of the 

following: 

• Choose Reset notes from Settings menu to 

undo all changes you have made. 

• To open saved notes table click to the button 

Load Notes. 

 

Notes file permits for filtering against known false-

positive signals in microarray (see also section 2.6.1).  
 
Note: The notes made will be saved with grn file 
extension 

 

2.6.5 Using Reference 
 

 

To edit reference table do the following: 

• Click Reference menu to open reference table. 

• Click a cell to select. 

• Press the Enter key on the keyboard to enter 

new value. 

• Two last symbols if these consist of A, C, G or 

T, will be used for comparing with the sample 

basecall. The other symbols may indicate the 

gene, base position in the sequence, SNP ID 

and DNA strand (se and s – sense, as – 

antisense), for example: 

   

To undo changes in reference table do one of the 

following: 

• Choose Reset reference from Settings menu to 

undo all changes you have made. 

• Choose Reference table from Load menu to 

open saved reference table. 

 

Note: The reference file will be saved with grf file 
extension 

 

Sense 

 

 

Antisense 

 

TP53 12139se CG 

Signal intensity 
of the position 

Info from 
Reference file 

Info from Notes 
file 

Location of PicDB 
database 

The same position of other samples within 
selected PicDB database 
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2.7 Signal Normalization and Results Window Settings 
 

 

By default, signals are compared according to their actual 

values from microarray quantification (real values). 

However, the scale and intensity distribution of signals 

may differ between the different microarray images 

corresponding to different fluorescence channels. These 

differences are reduced by different normalization 

methods.  

 

To specify signal normalization method do the 

following: 

• Click the Normalization menu on the Results 

window (See Figure 13.). 

 

By the signal maximum value The few most intense 

signals in each image will be used for linear 

normalization. 

The software includes two empirical data normalization 

algorithms: 

 

By weakest nucleotide 100 most intense signals from 

each of the images are selected as a reference for 

comparison. The average values for this set of signals 

are compared and all signals from three images (except 

the one with the smallest average value) will be divided 

with the variable from the comparison of 100 most 

intense signals. 

 

By distribution of signals This assumes that the signal 

intensity histograms must be equal between different 

images. All signals from each image are ranged ( 1st, 

2nd, 3rd, etc.). Signals with the same number in the 

sequence are compared and the more intense signal 

values adjusted to the level of the signal value from the 

weakest image (e.g the second strongest signal from A, 

C and T images must have the same value as the second 

strongest from G image, etc.). 

 

 

 

2.7.1 Visualizing Results With Spectra and Graphs 
 

 

Click the Chart menu on the Results window (See Figure 

13.) 

 

To visualize results click one of the  

following buttons: 

 

Histogram of intensities Use this tool to see the 

number of signals corresponding to different signal 

intensities. 

 

Histogram of distances Use this tool to view 

distribution of distance measure used for comparison with 

wild-type reference DNA. 

 

Number of clusters Use this tool to view the number of 

data clusters per microarray position (per given APEX 

oligonucleotide). The graph illustrates the reproducibility 

of signal patterns with a wild-type reference DNA if this is 

used for comparison with the analyzed sample. 

 

Distance from clusters Use this tool to visualize 

distances (differences) from the reference dataset (See 

Figure 16.). The positions with zero distance have a 

perfect match with the analyzed sample. The bigger the 

value of distance measure is the bigger is the probability 

of mutation. 

 

Clarity of signals Use this tool to show positions with 

multiple secondary signals in case of otherwise 

homozygous samples (summarizes signal values between 

0 and 100%). The graph is useful when determining the 

reaction specificity, but is not informative with a chip 

showing many heterozygous positions. The scale is shown 

below the graph. Dark grey areas show missing signals 

on the chip. 

 

 

 

Figure 16. The distance from clusters window 

 

 

 

Mutation site differs from signal data 
obtained with the wild-type reference sample  
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2.7.2 Specifying Base Calls Table Options 
 

 

Use the base calls table options to specify when cells are 

shown with a light blue background. The blue cells 

indicate the possibility of an artifact in microarray 

images (according to the selectable criteria in Options 

→ Blue Cells panel) and prompt user to analyze the 

address manually. 

 

 

 

 

 

 

 

To assign Blue Cells in BaseCallerTM main window 

and results window: 

• In BaseCallerTM main window choose Options 

from Tools menu 

• In Results window choose Blue Cells from 

Settings menu  

 

• Single signals above the minimum level of 

secondary signals Use this option to check all 

cells where both recurrent signals and weaker 

single signals are found. 

• Possible errors or artefacts (marked as ’!’ ) 

Use this option to check all cells, which do not 

match the reference table and may indicate 

mutations. 

• Missing signals (marked as ’.’ ) Use this 

option to check the cells where no signals are 

identified. 

• Exceeding distance from clusters Use this 

option to check all cells, which do not match the 

clustered signal patterns from the reference 

sample. 

• Sense/anti-sense non-conformities Use this 

option to check all cells where the signals from 

sense strand do not match the signals from 

antisense strand. * 

 

* Note: It is assumed that both strands give signals 
complementary to each other. This is the situation with 
typical oligonucleotides for APEX, but not with allele 
specific ologonucleotides (ASO). 
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2.8 Saving and Exporting Results 
 

Genorama® lets you save and export signal and base 

calls tables, reference and notes table. 

 

To save signal tables do the following: 

• Choose Four tables: A, C, G, T from Save 

menu 

 
To save base calls table do the following: 

• Choose Current table from Save menu with 

base calls window active 

 

To save reference table do the following: 

• Click the Reference menu. 

• Choose Current table from Save menu. 

 

To save notes table do the following: 

• Choose Notes table from Save menu 

• Save Current table as Notes table 

 

To save full signal statistics do the following: 

• Choose Save full signal statistics from Tools 

menu of BaseCallerTM Main window. Save 

window appears. Select the folder, appropriate 

filename and proceed with signal scanning. 

 

 

To export signal tables do one of the following: 

• Choose Current table from Excel menu. 

• Choose Signal tables as column from Excel 

menu. 

 

To export base call table do one of the following: 

• Choose Current table from Excel menu. 

• Choose Base call table as string from Excel 

menu. 

• Choose Base call table as column from Excel 

menu. 

 

To export reference table do the following: 

• Click the Reference menu. 

• Choose Current table from Excel menu. 

 

To export notes table do the following: 

• Click the Notes menu. 

• Choose Current table from Excel menu. 

 

 

Note: If untracked blue cells are exported, question 
marks appear in the cells. 
 

 
 

 

2.8.1 About File Formats for Signal values, Basecalls and Notes 
 

 

BaseCallerTM results are presented in table format and 

can be saved in many formats: 

• Signal intensity tables (Genorama® results 

table, *.grs; full signal statistics table *.txt) 

• Text table (Genorama® base calls, *.grb) 

• Table of notes (Genorama® notes, *.grn). 

 

All the results can be exported to MS Excel in various 

selected formats. 

 

Full signal statistics table (See Figure 17.) contains 

information on image, address, signal intensity value, 

signal pixels (S_mean, min, max), local background 

pixels (B_mean, min, max), signal area in pixels 

(S_area), diagnostic comment if the signal is not found, 

Notes and Reference file. 

 

For information on diagnostic comments, please contact 

Asper tech support.  

Examples of the comments: W3-very low intensity of the 

possible signal, C3-very low number of possible signal 

pixels. 

 

 

 
 

 

Figure 17. Full signal statistics table.  
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3 PicDBTM 
 

3.1 Working with PicDBTM Image Database 
 

 

You can create the database of APEX images 

corresponding to each cell on the grid by using the 

BaseCallerTM program. PicDBTM lets you to compare all 

the array positions at all images. The images can be 

analyzed visually or with different quantitative formats.  

Note: According to signal intensities from four different  
channels, all images corresponding to same address  
are shown in two scatter plots, for sense and antisense  
strands.  
 

 

 

 

 
 

 

Figure 18. PicDBTM image database analysis program main and base calls windows 
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3.1.1 Opening Image Database 
 

To open image database: 

• Choose Load image database from File menu.  

 

Image databases are automatically named according to 

their grid dimension values. For example if your grid has 

20 horizontal and six vertical cells, the image database 

name is 20x6_1.mdb. Databases exceeding 500MB will 

be automatically split by the software (20x6_1.mdb, 

20x6_2.mdb, etc.). User will still be able to open all the 

data simultaneously by opening just the first file 

20x6_1.mdb. (See also section 2.4) 

3.1.2 Determining Image Address 
 

To specify sample position from the database: 

• Drag the Address: Row. Col. sliders  

 

Vertical slider changes row address and horizontal slider 

changes column address. 

Z and X keys set focus on vertical and horizontal sliders 

and the address may be changed by pressing respective 

arrow key. 

 

 

 

 

 
 

Figure 19. PicDBTM main window 

toolbar. 

 

 

 

3.1.3 Adjusting Image Brightness 
 

Using brightness command is the simplest way to adjust appearance of your samples. 

 

Click the Show/Scan images button on PicDBTM main window toolbar (See Figure 19.) 

to view image database in determined position. All positions from different images are 

visualised and automatically scanned. Also, there are histograms and automatic base 

calls. 

 

To adjust image brightness do the following: 

• Drag the Brightness slider right to increase samples brightness level. 

• Drag the Brightness slider left to decrease samples brightness level. 

• Click the Show/Scan images button to view samples with new brightness 

level. 

 

 

3.1.4 Choosing Image Palette 
 

PicDBTM lets you view images with Rainbow, Plasma or Grayscale palette (See also 

Figure 4.). Different image palettes are for better visual identification and do not affect 

the results. 

 

To change image palette do the following: 

• Click the Rainbow, Plasma or Grayscale radio button. 

• Click the Show/Scan images button to view samples with new image 

palette. 

 

 

3.1.5 Scaling Images 

Use this option to specify the visualized scale of the microarray images. 

 

Absolute This scale corresponds to the actual scale of TIFF images. Use this option to 

see if any saturated signals exist. 

Relative by image This scale shows all signals independent on their intensities. This is 

the recommended visualization option for routine analysis. 

Relative by sample This scale corresponds to the minimum and maximum intensities 

of the whole sample. Use this option to compare the signal intensities between A, C, G 

and T images. 

Relative by address This scale corresponds to the minimum and maximum intensities 

of the whole image database. Use this option to compare the signal intensities between 

different samples. 
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3.1.6 Changing Image Scanning Options 

 

To change scanning options do the following: 

• Click Options menu on menu bar, the 

options table appears. Mostly the options are the 

same as in BaseCallerTM (See section 2.5.1), there 

are few PicDBTM specific scanning options: 

 

Show red-green corners use this option to 

visualize found signals. All the green ones are found 

signals and red ones are not. 

Recurrent signals only This option affects the 

results if there are some missing signals. If one of 

the two recurrent signals is missing, then it won’t be 

considered as true signal. This option affects signal 

intensities, histograms, basecalls and graphs. 

 

Min. level of secondary signals for basecalling 

Use this option to check all positions where both 

recurrent signals and weaker single signals are 

found. 

 

Local background subtraction - Use this option to 

subtract the value of the background around the 

spot from the integrated volume of pixel intensities 

used for calculation of the signal intensity value. 

 

Sensitivity - Use a sensitivity threshold to eliminate 

low intensity signals 

0% - only signals with high intensity are counted 

100% - all found signals are counted and quantified. 

 

To view samples with new image scaling and adjusted 

scanning options: 

• Click the Show/Scan images button.  

 

 
 

Figure 20. The Image scanning options window in PicDBTM. 

 

 

3.1.7 Using Sample Filter 
 

 

PicDBTM lets you filter your samples by name or against 

name.  

 

To apply sample filter do the following: 

• Click the Filter menu. The filter window (See 

Figure 21.) 

• Enter the sample name(s) and click OK. 

Samples with a given phrase in the sample 

name will be shown or hidden. 

 

To select particular samples for analysis: 

• Click Selected samples button. The selected 

samples window (See Figure 22.) appears. 

• Select the number of sample to be viewed in 

main window. 

 

 

 

 
 

Figure 21. The filter window 
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Figure 22. The selected samples window. 

 

 

3.1.8 Using Reference 
 

To select the appropriate reference file:. 

• Click the icon next from Reference window  

 
 

• Drag the Address: Row. Col. Sliders to select 

the microarray position for analysis.  

• Reference information for the same position will 

be shown. 

 

To create a new reference file: 

• Select New from Reference menu. 

 

 

3.1.9 Using Notes 
 

To select the appropriate notes file:. 

• Click the icon next from Notes window 

 
 

Use the Notes tool to see saved comments or notes on 

performance of particular array positions such as 

possible unspecific signals. 

 

 

To create a new notes file: 

• Select New from Notes menu. 
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3.2 Grouping Samples in Graph Window 
 

 

The Graph tool lets you group the samples. On Scatter-

blot all dots can be selected and analyzed separately. 

The white dots are not yet analyzed, the green dots are 

selected and the red dots are already edited or saved. 

 

 

3.2.1 Specifying Graph Drawing 
Options 

 

Logarithmic scale Deselect the logarithmic checkbox 

to see signal values in linear scale. 

 

Clusters by: 

Signal values Use this option to set two specified 

images (e. g. A and G) to correspond to X and Y-axis. 

Allelic fractions Use this option to set X axis to show 

the summarized signals from two specified images and Y 

axis to show the distribution of signals according to their 

allelic fractions. 

 

To select samples with the Graph tool do the  

following: 

• Select Arrow or Square radio button 

• Click the dots you want to select in Sense or 

Antisense window. 

 

To select samples from Base Calls (BC) column do 

the following: 

• Press Shift key and click on the value you 

want to select in the BC column. 

• Alternatively, select all basecalls by pressing 

Shift key and clicking by mouse left button 

with the pointer on the BC column label. This 

selects only the raw, nonsaved data (with light 

grey background). 

 

  
 

 

To deselect samples with Graph tool do the 

following: 

• Select Arrow or Square radio button 

• Press Shift key and click the dots you want to 

deselect in the Sense or the Antisense window. 

 

To deselect samples from Base Calls (BC) column 

do the following: 

• Press Shift key and click on the value you 

want to deselect in the BC column. 

 

 

To view where the certain sample is located on 

graph do the following: 

• Click on the sample number 

 

To reset graph do the following: 

• Click the Reset button. 

 

 

 
 

Figure 23. Part of PicDBTM main window 
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3.2.2 Cluster Analysis of Genotyping Results 
 

 

PicDBTM has a built-in clustering tool for the genotyping results. 

The tool is mostly optimized for single nucleotide polymorphism 

genotyping 

 

To use the clustering tool for visual 

indications of the assumed genotype clusters: 

• Open the Options panel. 

• Select Perform cluster analysis.  

• The colouring options in charts include 

a vertical ribbon or small circles in the 

background of the data for each sample 

• Gray signals in cluster borders will 

eliminate errors in rare cases, where the 

genotype clusters will overlap in result of 

the automated analysis from both strands 

(recommended) 

 

 

Figure 24. PicDBTM cluster analysis options for basecalling and visualization in charts 
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3.3 Working with Samples 
 

3.3.1 Identifying Signals in 
Detailed View 

 

Double-click on any of the sample to open the detailed 

view of selected cell. Every pixel is one block and its 

height depends on signal intensity. 

 

The Zoom tool lets you scale signal intensities. Use it 

to identify complex or faint signals visually. 

 

 

3.3.2  Editing Base Call Values 
 

Click the sample base call (BC) field and enter the 

new value. 

 

To set the same base call values for all selected 

samples: 

• Click the Same base call for all selected 

images checkbox (See also section 3.2.1). 

Note: The changes will also affect all 

basecalls from cluster analysis, i.e. BC fields 

with identical background colour. 

 

To use cluster analysis for genotyping:  

• Click on Base calls/Auto scan button or press 

Alt+A. 

• Select whether BC field will be formed of 

cluster analysis results or by minimum level 

of secondary signals for each primer site. 

• Select the number of clusters required (Auto, 

3, 2, 1). 

• Testing for Sense/antisense conformity 

provides additional precision for automated 

basecalling 

 

Note: to keep the selected options, close Base 

calls window 

 

 

 
 

Figure 25. PicDBTM Base calls window 

 

 
 

Figure 26. Part of PicDBTM main window 
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3.3.3 Changing Sample Name 
 

PicDBTM lets you change sample names you set in 

BaseCallerTM (See section 2.4). 

 

To change sample name do the following: 

• Choose Admin menu from Menu Bar of 

PicDBTM image database analysis program 

main window (See Figure 18.) . The Admin – 

rename, delete and restore samples 

window appears. 

• Select the sample name from the list, the 

name appears in the black area. 

• Click Rename and type new name. 

• Click Save. 

 

 

3.3.4 Deleting and Restoring 

samples 
 

To delete samples do the following: 

• Choose Admin menu from Menu Bar of 

PicDBTM image database analysis program 

main window (See Figure 18.) . The Admin – 

rename, delete and restore samples 

window appears. 

• Select the sample name from the list, the 

name appears to the black area. 

• Click Delete. 

Deleted samples remain in the database, but  are not 

visible in PicDBTM analysis window. 

 

Deleted samples can be easily restored. 

 

To restore deleted samples do the following: 

• Choose Admin menu from Menu Bar of 

PicDBTM image database analysis program 

main window (See Figure 18.) . The Admin – 

rename, delete and restore samples 

window appears. 

• Select the sample name (with *DEL* in the 

beginning) from the list, the name appears in 

the black area. 

• Click Restore to restore deleted samples. 

 

 

3.3.5 Listing Samples 
 

To see the list of samples do the following: 

• Choose Admin menu from Menu Bar of PicDBTM 

image database analysis program main window 

(See Figure 18.) . The Admin – rename, delete 

and restore samples window appears. 
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3.4 Saving and Exporting Results 
 

3.4.1 Saving Results 
 

 

To save results do the following: 

• Choose Save results from Results menu. The 

save results window (See Figure 27.) appears. 

 

Continue with analysis Choose this option to close 

dialog box without saving. This will keep your selection 

and you can continue with analysis of the same 

microarray position. 

 

Save edited results Choose this option to save the 

edited results. The edited results consist of cells with 

any coloured background from analysis, except for 

the default light gray background for raw base calls 

 

Save all results – choose this to save the analyzed 

position in the whole database 

 

Do not save results - Choose this option to cancel 

saving and go to the next position.

 

Figure 27. The save results window. 

 

3.4.2 Visualizing Results 
 

 
 

Figure 28. The Show results window. 

To visualize results do the following: 

• Choose Results from menu bar.  

• Choose Show Results/Export to Excel. 

• The show results window (See Figure 28.) 

appears. 

 

The Show results tool lets you see, which positions and 

samples are already analyzed and saved. Red cells mark 

the saved positions.  

 

3.4.3 Exporting Results to Excel 
 

Al the results can be exported to MS Excel in various 

selected formats. 

 

To export results to Excel do the following: 

• Click on the button To Excel to export the 

results to MS Excel 

• Or click on the button To txt.file to export the 

results to Notepad. 

 

 

3.4.4 About File Formats 
 

PicDBTM Results are automatically saved in Agenda file 

(...ag.mdb) in the same folder with the Image Database 

analyzed. 
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4 Genorama® ConverterTM 
 

4.1 Converting Text Table to Genorama Reference Table 
 
Genorama® ConverterTM utility lets you convert a tab 

delimited text table into a Genorama 4.5 reference table 

or 20-space blocks for Genorama 4.2 or older versions.  

The Excel table has to be made in the similar layout as 

the final grid on the slide (See Figure 29.). 

 

To convert the Excel file onto Genorama® ConverterTM 

reference table, save the table as tab delimited text 

first. 

 

To convert tab delimited text table into a 

Genorama reference table: 

 

• Open Genorama® ConverterTM 

• Click File on menu bar to load txt file 

• If you use Genorama 4.5 choose Save in new 

standard option and if you use Genorama 4.2 

or older choose Save in old standard option 

(See Figure 30). 

• Click to button Save and choose the target 

folder. 

 

 

 
 

Figure 29.  Similar layouts of Reference files in MS Excel and Genorama® BaseCallerTM. 
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Figure 30.  Genorama® ConverterTM main window. 
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